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VISION STATEMENT
To expand our capabilities and capacities to
be the best value rapid deployment logistics
platform to satisfy joint war fighters’ mate-

riel requirements during peacetime and
national emergencies

Welcome to ISO 9001:2000
Sierra Army Depot is ISO

9001:2000 third-party certified as of
May 25, 2005.  ISO is a Quality Man-
agement System that outlines some
basic good business practices that we
need to have in place.  By complying
with ISO 9001:2000, we will be able
to make our company run more effi-
ciently, increase our customers’
satisfaction and communicate to po-
tential customers that we have good
quality processes in place.

What will employees need to
do for the ISO 9001:2000 Quality
Management System?

First Management will be identify-
ing our “Key Processes”.  Those are
the processes that affect the quality of
our product and our services. Then
they will identify how we will control
these processes to make sure that we
are all doing them the same way, and

the best way our organization has iden-
tified.

Controlling the process means
documenting the work instructions,
training employees or finding other
ways to make sure that the process is
done consistently no matter who is
doing it.  This means that employees
may be required to have certain train-
ing, or to follow specific work
instructions.

Employees will also need to be
aware of how their job affects the qual-
ity of our product and customer
satisfaction.

ISO 9001 Highlights:  Things
that you will be hearing about as we
proceed with this project….

Our Quality Policy
We have developed our Quality

Policy, and have communicated it to
99% of all employees.

Quality Policy: Sierra Army
Depot is committed to meeting re-

By Lynette Hall
QEO Office

Improving the quality of
daily business practices

ISO (See Page 4)
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Army Materiel Command Deputy Commanding
General comes to  SIAD
By Lori McDonald
Public Affairs Officer

Lt. Gen. William Mortensen, Army
Materiel Command Deputy Command-
ing General, visited here in April for the
first time since assuming his new posi-
tion.

Upon landing at Amedee Army
Airfield located on the installation,
Mortensen had the opportunity to climb
aboard a Blackhawk helicopter pro-
vided by the Nevada Army National
Guard for an aerial of the depot.  The
helicopter then landed near the Head-
quarters building, where Mortensen was

provided a command briefing by Mike
Pilkington, Director of Mission Opera-
tions.  The briefing topics included
current programs, financial trends,
safety, Lean Six Sigma, BRAC and the
airfield extension project.

Mortensen said AMC will need to
identify a wedge for the FY08 - FY13
budget to support increase returns of
the AJ1 operations and receipt/storage
of other returns from Southwest Asia
based on theater drawdown.  “Light
maintenance reset fits well into SIAD’s
core competencies and I’d rather have
it done here,” Mortensen said.

DEPUTY (See Page 2)

John Dingman, left, and Joe Henderson explain to Lt. Gen. William
Mortensen, AMC Deputy CG, the tracking board that is used within the AJ1
operation that identifies containers received and timeframes required to
process the equipment.  This is just one area within the installation SIAD
has implemented and is improving through the Lean Six Sigma concept.

Photo by Lori McDonald
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Unless otherwise noted, all articles and photo-
graphs are provided by the editorial staff.  Letters
to the editor and classified ads must include a
name, signature and telephone number to be con-
sidered for publication. Letters may be edited to
fit space.
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To Keep the Work force in-
formed on the procedures and
personnel involved in the A-76
competition there will be a series
of Articles written explaining the
A-76 process.  If there are any ques-
tions that you might have please
send me an e-mail to
james.swistowicz@sierra.army.mil,
with your question(s) and I will re-
spond with an e-mail and print the
question with the answer(s) in the
next issue of the Challenge.

Below are the Competition Of-
ficials and their duties.

Competition Officials.  Appoint
competition officials.  The Competi-
tive Sourcing Official (CSO) shall
appoint competition officials for each
standard competition, and, as appro-
priate, may appoint competition
officials for streamlined competitions.
The CSO shall appoint all competition
officials, in writing, and shall hold these

competition officials accountable for the
timely and proper conduct of stream-
lined or standard competitions through
the use of annual performance evalua-
tions.

a.  Agency Tender Official
(ATO).  The ATO shall (1) be an in-
herently governmental agency official
with decision-making authority; (2)
comply with this circular; (3) be inde-
pendent of the contracting officer (CO),

source selection authority (SSA),
source selection evaluation board
(SSEB), and performance work state-
ment (PWS) team; (4) develop, certify,
and represent the agency tender; (5)
designate the most efficient organization
(MEO) team after public announcement
of the standard competition; (6) pro-
vide the necessary resources and
training to prepare a competitive agency
tender; and (7) be a directly interested
party. An agency shall ensure that the
ATO has access to available resources
(e.g., skilled manpower, funding) nec-
essary to develop a competitive agency
tender.  COL Brian Butler.

b.  Contracting Officer (CO).
The CO shall (1) be an inherently gov-
ernmental agency official; (2) comply
with both the FAR and this circular; (3)
be independent of the ATO, human
resource advisor (HRA), and MEO
team; and (4) be a member of the PWS

team.  Mr. Mike Yilmaz (from HQ
TACOM Warren),

c.  PWS (Performance Work
Statement) Team Leader.  The PWS
team leader shall (1) be an inherently
governmental agency official; (2) com-
ply with both the FAR and this circular;
(3) be independent of the ATO, HRA
and MEO team; (4) develop the PWS
and quality assurance surveillance plan;
(5) determine government-furnished
property (GFP); (6) assist the CO in
developing the solicitation; and (7) as-
sist in implementing the performance
decision.  Jim Swistowicz, Bill
Benningfield.

d.  Human Resource Advisor
(HRA).  The HRA shall (1) be an in-
herently governmental agency official
and a human resource expert; (2) com-
ply with this circular; (3) be independent
of the CO, SSA, PWS team, and
SSEB; (4) participate on the MEO

UNION (See Page 5)

As the weather warms up, we’re
beginning to see more traffic and the
start of construction on I-395 in both
directions from the depot.  This greatly
increases the risk for our employees
traveling to and from work on a daily
basis, so extra caution is needed.
Please drive carefully and be alert at
all times as we need each and every
one of you to continue the great sup-
port we provide to our Nation’s
Warfighters every day.

Lt. Gen. William Mortensen,
Army Materiel Command Deputy
Commanding General visited the de-
pot on April 11, 2006.  Although his
visit was very short, he left an incred-
ibly positive impression with the depot.

Lt. Gen. Mortensen stated AMC
will explore more long term work for
Sierra Army Depot that matches our
core competencies, i.e., long term
storage of operational project stocks,
receipt/shipment (redistribution), ship-
ment consolidation, set assembly,
COSIS, light maintenance and repair,

long term storage of tracked and
wheeled vehicles, and selected reset
missions.

He was extremely impressed with
the professionalism of our work force
and the potential of our facilities, and is
committed to helping us establish long-
term work that will provide us the

stability we’re searching for in terms
of funded workload.

Our next visitor will be Gen. Ben-
jamin Griffin, AMC Commanding
General, in early May.  This is Gen.
Griffin’s second trip to the Depot, and
he remains a staunch supporter.  I am
confident that Gen. Griffin will be
pleased with the progress of our op-
erations since his last visit, and will
depart SIAD with the confidence that
we remain a critical link in ensuring
timely, complete support to our Sol-
diers in the field.

As we become more active in
marketing our capabilities, one area
that is really paying off is the efforts of
our reserve coordinators. Units and in-
dividuals are increasingly aware of our
capabilities, and are increasingly tak-
ing advantage of the opportunities that
are unique to SIAD.  This month, Sol-
diers will be conducting training
throughout the depot and active duty
Airmen will conduct an airfield seizure

Lt. Col. Brian D. Butler

COMMANDER (See Page 3)

Additionally, he stated AMC
will need to explore more long term
work for SIAD that matches the
depot’s core competencies, i.e.,
long term storage of operational
project stocks, receipt/shipment
(redistribution), shipment consoli-
dation, set assembly, COSIS, light
maintenance and repair, long term
storage of tracked and wheeled
vehicles, and selected reset mis-
sions.

After the briefing, Mortensen
was given a windshield tour of the
warehouse area, with a walk
through of the AJ1 operations.
Mortensen said the future for SIAD
is steady and work will be forth-
coming.

DEPUTY:  (From Page 1)

May 29, 2006 is a
day we pause to relfect,

and most importantly, to
honor the memories and

sacrafices of those Soldiers,
sailors, airman, Marines and
Coast Guard who have lost
their lives fighting for this

great country.
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SIERRA
ARMY DEPOT
HAS WORKED

4 DAYS
SINCE OUR

LAST
ACCIDENT

As of April 24, 2006
Look for this sign as you come through the main gate

Most hazardous location,
occupation and injury for

the month of April

General Support Worker

Warehouse 304

Back Injury

exercise involving multiple aircraft and
personnel at Amedee Army Airfield.
While they’re here, I know I can count
on all of you to display the pride and
professionalism that has become the
hallmark of our operations.

As a final note, every few minutes,
someone, somewhere – maybe a friend
or a relative, needs blood to get them

through a critical injury or illness.  As a
blood donor, you may hold the key to
that person’s future.  On May 18,
2006, please try to give that gift of life.
It only takes a few minutes to donate,
but the benefits to someone in need is
a matter of life and death.

Thanks for all you do, ever single
day!  Let’s get to work!

COMMANDER (From Page 2)
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Understanding Contracting 101
Small businesses play an important role in sup-

porting the Depot’s needs.
You probably didn’t know
that all purchases between
$2,500 and $100,000 are
automatically reserved for
small business.  The Con-
tracting Office also has a
commitment to make ev-
ery effort to set-aside
procurements that are
over $100,000 for small business.  This includes a
requirement to obtain competition from two or more

Small Businesses small businesses.  Soliciting a quote from one small
business and making a subsequent award doesn’t sat-

isfy this reservation/set-aside
requirement.

There are exceptions to the above,
but they must be adequately justified.
For instance, sometimes only the origi-
nal equipment manufacturer can
provide a part and they just happen to
be a large business.

Additionally, there are small busi-
ness award targets that are assigned

throughout the Department of Defense which trickle
down to us through the Army Materiel Command and

quirements and continually improving the effec-
tiveness of our Quality Management System.

It is important that all of us are aware of what this
statement says about our company’s vision meeting
customers’ expectations and for quality.

Internal and Surveillance Audits
The ISO Team at Sierra scheduled and con-

ducted Internal Audits between January 23, 2006 and
March 31, 2006.  Perry Johnson Registrars will send
an auditor or an audit team to come into our facility
and evaluate the processes we have set up.  They will
check to see if the processes meet the requirements
of the standard, if we are following the processes.  If
everything looks good, we will remain ISO Certified.
The Auditor was at Sierra on April 18 - 19, 2006.
Information of how well we did or did not do will be
in the next issue of the Challenge.

ISO:  (From Page 1)

Before I talk about Ben, I want to remind every-
body to use their P.O. Box numbers as their mailing
addresses.  I wish I could say that things are better
since I wrote an article concerning this a couple of
months ago.  Many of you are still receiving mail ad-
dressed to your street address.  Let me reiterate that
this could slow down your receiving your mail and you
might not even receive it at all.  If whoever is handling
the mail doesn’t know the recipient’s box number, she
can return it to sender.  On the other hand, let me
apologize for mail you receive that does have your box
number, but has a different name on it.  We try to look
at every name as the mail goes into the box, but some-
times we get in a hurry and mistakes happen.

Also, some customers are not aware that you can
pay for a money order or any postal product with a
Debit card.  It’s a lot easier than having to go to the
Credit Union for cash first.  Some Debit cards have

limits, but I know that the limit can sometimes be raised
through your bank.

Now, about Benjamin Franklin, America’s
Leonardo de Vinci.  We have a new series of stamps
honoring the man and he was quite an interesting fel-
low.  According to the back of one of the stamps,
Benjamin Franklin was “vital to the organization of the
American postal system, serving as postmaster of
Philadelphia and a deputy postmaster for the Ameri-
can colonies before being appointed Postmaster
General by the Continental Congress in 1775.  He
marked postage-free letters with his unique personal
signature: ‘B.Free Franklin.’”

A second stamp in the series talks about Ben
Franklin being “deeply involved in politics and civic
life.  He served in the Continental Congress and signed
both the Declaration of Independence and the Con-
stitution.  Often considered America’s first diplomat,
Franklin negotiated an alliance with France and helped
to secure a peace treaty with Great Britain.”

Tank-automotive and Armaments Command.
TACOM-Warren divides these targets among the
various subordinate installations.

Why is this information important to end users?
We want you to keep the small business community
in mind when you are preparing your requirements.
Try not to be restrictive with your statements of work
as to preclude small businesses from participating in
the procurement.  Additionally, you need to allow us
time to obtain competition among the many small
businesses that want to do business with the Depot.

Without the support of the requirements commu-
nity, it would be impossible to significantly contribute
to Army’s assigned targets.  Thanks!!!

Ben Franklin and other things postal
By Christine Olson
Herlong Postmaster

The third stamp honors Ben Franklin as a printer.
“From his childhood apprenticeship in Boston to his
career in Philadelphia as an adult, Benjamin Franklin
enjoyed a lifelong association with printing. In addi-
tion to the Pennsylvania Gazette and Poor
Richard’s Almanack, his presses also printed a wide
range of materials, such as government pamphlets,
religious tracts, currency and books.”

Lastly, the fourth stamp brings to mind Ben
Franklin’s scientific prowess. “Remembered for the
pursuits he called ‘philosophical amusements,’ Ben-
jamin Franklin was intensely curious about natural
phenomena. His observations and experiments in ar-
eas such as electricity and meteorology resulted in
interesting inventions, including a heating stove, the
lightning rod and an early electrical battery.”

Come into the post office and see these stamps,
but don’t try to fly a kite in a thunderstorm like Ben-
jamin Franklin did!

A corporate attorney sent the following advise
out to the employees in his company.

1. The next time you order checks have only your
initials (instead of first name) and last name put on
them. If someone takes your checkbook, they will
not know if you sign your checks with just your ini-
tials or your first name, but your bank will know how
you sign your checks.

2. Do not sign the back of your credit cards.
Instead, put “PHOTO ID REQUIRED.”

3. When you are writing checks to pay on your
credit card accounts, DO NOT put the complete
account number on the “For” line. Instead, just put
the last four numbers. The credit card company knows
the rest of the number, and anyone who might be
handling your check as it passes through all the check-
processing channels will not have access to it.

4. Put your work phone number on your checks
instead of your home phone. If you have a PO Box,
use that instead of your home address. If you do not
have a PO Box, use your work address. Never have

your social security number printed on your checks,
(DUH!). You can add it if it is necessary. However, if
you have it printed, anyone can get it.

5. When you check out of a hotel that uses cards
for keys (and they all seem to do that now), do not
turn the “keys” in. Take them with you and destroy
them. Those little cards have on them all of the infor-
mation you gave the hotel, including address and credit
card numbers and expiration dates. Someone with a
card reader, or employee of the hotel, can access all
that information with no problem whatsoever.

This attorney experienced first hand the conse-
quences a person lives with when your wallet is stolen.
Within a week, the thieve(S) ordered an expensive
monthly cell phone package, applied for a VISA
credit card, had a credit line approved to buy a Gate-
way computer and received a PIN number from DMV
to change the attorney’s driving record information
online.

Attorney’s advice — No charge

ADVICE (See Page 12)
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Memorial Day is more than flags flying for a holiday.  It is a symbol that we annually rededicate our-
selves to carry forward the torch of freedom which the brave men and women throughout this nation’s
history have passed to us as they were struck down.

We cannot honor them enough for the price they have paid to provide for us a way of life in which we
value highly the worth of freedom.  Our work for freedom is never finished.  From them we have learned
that we must be willing to guard our freedom and be ready to fight for it.  They have given us the goal of
peace and strong military defenses are the guardians of that peace.

Let us each take that moment of silence on this Memorial Day to pay our personal tribute to those who
have insured for us the priceless heritage of freedom and pray for that continuous uniting of soldier and
civilian which will preserve our heritage for the future of all mankind.

On August 31, 1949, Secretary of Defense Louis
Johnson announced the creation of an Armed Forces
Day to replace separate Army, Navy and Air Force
Days. The single-day celebration stemmed from the
unification of the Armed Forces under one depart-
ment — the Department of Defense. Each of the
military leagues and orders was asked to drop spon-
sorship of its specific service day in order to celebrate
the newly announced Armed Forces Day. The Army,
Navy and Air Force leagues adopted the newly
formed day. The Marine Corps League declined to
drop support for Marine Corps Day but supports
Armed Forces Day, too.

In a speech announcing the formation of the day,
President Truman “praised the work of the military
services at home and across the seas” and said, “it is
vital to the security of the nation and to the establish-
ment of a desirable peace.” In an excerpt from the
Presidential Proclamation of Feb. 27, 1950, Mr.
Truman stated:

Armed Forces Day, Saturday, May 20, 1950,
marks the first combined demonstration by
America’s defense team of its progress, under the
National Security Act, towards the goal of readi-
ness for any eventuality. It is the first parade of
preparedness by the unified forces of our land,
sea, and air defense.

The theme of the first Armed Forces Day was
“Teamed for Defense.” It was chosen as a means of
expressing the unification of all the military forces un-
der a single department of the government. Although
this was the theme for the day, there were several
other purposes for holding Armed Forces Day. It was
a type of “educational program for civilians,” one in

which there would be an increased awareness of the
Armed Forces. It was designed to expand public un-
derstanding of what type of job is performed and the
role of the military in civilian life. It was a day for the
military to show “state-of-the-art” equipment to the
civilian population they were protecting. And it was a
day to honor and acknowledge the people of the
Armed Forces of the United States.

According to a New York Times article published
on May 17, 1952: “This is the day on which we have
the welcome opportunity to pay special tribute to the
men and women of the Armed Forces ... to all the
individuals who are in the service of their country all
over the world. Armed Forces Day won’t be a mat-
ter of parades and receptions for a good many of them.
They will all be in line of duty and some of them may
give their lives in that duty.”

The first Armed Forces Day was celebrated by
parades, open houses, receptions, and air shows. In
Washington D.C., 10,000 troops of all branches of
the military, cadets, and veterans marched pass the
President and his party. In Berlin, 1,000 U.S. troops
paraded for the German citizens at Templehof Airfield.
In New York City, an estimated 33,000 participants
initiated Armed Forces Day “under an air cover of 250
military planes of all types.” In the harbors across the
country were the famed mothballed “battlewagons”
of World War II, the Missouri, the New Jersey, the
North Carolina, and the Iowa, all open for public in-
spection. Precision flying teams dominated the skies
as tracking radar were exhibited on the ground. All
across the country, the American people joined to-
gether to honor the Armed Forces.

(Editor’s Note:  Information was obtained
from the Department of Defense web site - http://
www.defenselink.mil/afb).

“A Tradition of Heroes”
Armed Forces Day History

team; and (5) be responsible for the following: Lori
King (CPAC MER).

Leave Without Pay (LWOP):  I have attended
meetings where leave without pay has been a major
topic of discussion and I have had complaints where
LWOP has been denied and the employee charged
AWOL.  The Union’s position on this issue is this.
There are employees who have used up all their leave
due to a long term family illness and/or personal ill-
ness that has caused the employee to have little or no
leave on the books which is unavoidable.  Then there
are some employees that use the sick/annual leave as
soon as it is accrued, and when they need it for an ill-
ness or emergency or they just want some time off-
they don’t have the leave, and then they are charged
LWOP/AWOL depending on the circumstance.
There are thousands of hours of LWOP being used
throughout the Depot, some is legitimate- most is not.
It is our responsibility as depot employees to manage
our leave, not to mention it is a condition of employ-
ment to be at work.  There are options available if you
have used your leave and need time off for an extended
period of time or have no leave and wish to take time
off.  The options are :  (1) When you work overtime
work - take it as Comp time if you are eligible; (2) If
you have a long term illness or may require long term
medical care, apply for the leave donation program
or request advanced leave.  You can work through
your immediate supervisor to try and accommodate
your needs.  Remember that our customer, “the
Soldier in the Field” needs our support and we
need to provide them with the equipment they
need to complete their mission, we can only do
that by being at work.

Union meetings are on the first Tuesday of the
month in Bldg. 58  at 5:15 p.m.  Union Office phone
is x5375.

UNION:  (From Page 2)

On April 18, I was called up to the
Command Group to be recognized by
the Product Manager of the M1A1
Abram Tanks for my coordination with
the customer and support of the program
requirements. Although it is nice to be
recognized in this fashion, my recogni-
tion would not be possible without all
the hard work and support received from
those of you who are doing the “real”
work. I just wanted to take this oppor-
tunity to thank you all for the many things
that you do to make this program suc-
cessful for the customer and Sierra
Army Depot.

Please disseminate as appropriate to
other personnel involved in this program.

Thank you very much for all the hard
work.

A special thanks to
co-workers

Kathy Ayers
Program Manager

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

May 20th
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The employees of Sierra Army Depot were once again
recognized for their  commitment and dedication to support the
Soldier in the field during the Global War on Terrorism.  On
behalf of the employees, Mr. Vincent Sabatino, Civilian
Executive Assistant, receives a certificate of appreciation
(shown at right) from Col. Mark Yenter, XVIII Airborne Corps.

Tom Gordon, EEO Officer takes a few minutes to discuss the EEO program at SIAD with Command
Sgt. Maj. Otis Cuffee, TACOM CSM, during his first visit to the installation.

Lt. Gen. William Mortensen, AMC Depu
Joe Henderson explain the steps taken
depot and then stored until a mater
shipment to a using unit.  Don Olson, ch
Division talks with Robert Dittmann, A
Aide de camp to the AMC Deputy CG 
and processed on a daily basis.
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Kathy Ayers, center, is recognized by Linda Mentink, TACOM, and
Lt. Col. Brian D. Butler, depot commander, for her exemplary
service to the M1A1 Abrams progam including the receipt, storage
and issuance of Abrams tanks at Sierra Army Depot.  Ayers’
outstanding performance helped guarantee timely shipmnts of
Abrams tanks to meet both RESET requirements and USMC tank
progams.

The DARE program graduates from the Fort Sage Primary gather for a group photo with depot
commander and DARE Officer.  Front row left to right are C.J. Tong, Jonathan Crank, Alicia
Flecher, Sara Tong, Jessie Custer, Christina Breuning, Kiefer King and Brian Thomas.  Middle
row lft to right David Silva, Jason Manfull, Richard Crank, Lynette Child, Audrnae McGinnis,
Angela Hawley, Jamear Owens and Dalton Black.  Back row left to right Marsha Olsen, Ken
Holmes, Lt. Col. Brian Butler, depot commander, and Robert Brent, DARE Officer.

puty CG listens as John Dingman and
en when  AJ1 material is received on

erial release order is processed for
chief, Production Planning and Control
AMC G-3 Office and Maj. Robert Law,
G about the variety of items received
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Sierra
safety
dawg
says....

TTTTThank yhank yhank yhank yhank you,ou,ou,ou,ou,
RRRRRuss Collieruss Collieruss Collieruss Collieruss Collier, Safety Dawg, Safety Dawg, Safety Dawg, Safety Dawg, Safety Dawg

Use extreme caution
when driving in the In-
dustrial Area around
buildings 210 and 211. We have a contractor install-
ing a new sewer system which will be connecting the
bathroom facility in building 211 SE to the man hole
on the NE corner of 210. This construction will cause
some man made safety hazards such as open trenches
and areas where the pavement will be temporarily
replaced with aggregate material and it will also cre-
ate some confined space hazards. We should try to
avoid this area as much as possible during this con-
struction which should be completed this summer.

Drivers beware of the big ball of fire in the sky as
you drive onto the Depot! The Sun as some call it will
be directly in your eyes and has the potential to cause
us to make driving mistakes.  Please slow down and
if needed use sunglasses to make your entrance to the
Depot as Safe as possible.

Lastly anytime you do any task, think for an ex-
tra 10 seconds and make sure you can do it where
you won’t hurt yourself or someone working next to
you! Look for safety hazards constantly. Use the
S.E.E. Strategy, Search for hazards, Evaluate haz-
ards to avoid or eliminate and Execute your task
Safely!

Recently the Commander approved the SIAD
Suppl to AR 190-5 “Traffic Supervision” This Regu-
lation covers Traffic enforcement and other traffic
related issues on the installation. Below is a break
down of the offences that will affect your post driving
privileges. This regulation can be found on the intranet.

Again as always obey all traffic laws and be safe.
“33.  OFFENSE AND SUSPENSION PERI-

ODS:
a.  The following suspension or revocation peri-

ods will be utilized in accordance with AR-190-5.
(1)  Wanton excessive speed 21 or more over

posted limit - 6 months
(2)  Speeding with 1 or more prior traffic offenses

- 6 months
(3)   25 mph over posted limit - 1 year
(4)  Reckless Driving - 6 months
(5)  Hit and run - 1 year
(6)  Eluding Police - 6 months
(7)  Racing - 6 months
(8)  Driving without insurance - 6 months
(9)  Driving on a Suspended or Revoked License

- Civ-2 years/ Mil-5 years

b.  Assessment of 12 points in one year or the
assessment of 18 points within a two year period re-
quires a minimum 6 month revocation. “

New Cell Phone Use Restrictions on DoD
Installations

Employees are still seen around depot in violation
of the new cell phone use rstrictions while driving a
personal vehicle or a government vehicle.

•Per federal regulation (32 CFR 634.25), vehicle
operators on a DoD Installation and operators of
Government owned vehicles shall not use cell phones
unless the vehicle is safely parked or unless they are
using a hands-free device.

•The wearing of any other portable headphones,
earphones, or other listening devices (except for hand-
free cellular phones) while operating a motor vehicle
is prohibited.

•Violators may be issued a traffic violation.
For more information contact the Police Opera-

tions office at 827-4215.

Every day Ameri-
cans experience the
horror of fire, But most people don’t understand fire.
Only when we  know the true nature of fire can we
prepare ourselves and are families. Each year more
than 4,000 Americans die and approximately 20,000
are injured in fires, many of which could be prevented.

The United States Fire Administration (USFA)
believes that fire deaths can be reduced by teaching
people the basic facts that explain the particular char-
acteristics of fire.

· Fire is FAST
There is little time!  In less than 30 seconds a small

fire can get completely out of control and turn into a
major fire.  It only tacks minutes for thick black smoke
to fill a house. In minutes, a house can be engulfed in

flames. Most fires occur in the home when people are
asleep. If you wake up to a fire, you won’t have time
to grab valuables because fire spreads too quickly and
the smoke is to thick. There is only time to escape.

· Fire is HOT!
Heat is more threatening than flames.  A fires heat

alone can kill. Room temperatures in a fire can be 100
degrees at floor level and rise to 600 degrees at eye
level. Inhaling this hot air will scorch your lungs. This
heat can melt clothes to your skin. In five minutes a
room can get so hot that everything in it ignites at once:
this is called flashover.

· Fire is DARK!
Fire isn’t bright, it’s pitch black.  Fire starts bright,

but quickly produces black smoke and complete
darkness. If you wake up to a fire you may be blinded,
disoriented and unable to find your way around the
home you lived in for years.

· Fire is DEADLY!
Smoke and toxic gases kill more people than

flames do.  Fire uses up the oxygen you need and pro-
duces smoke and poisonous gases that kill. Breathing
even small amounts of smoke  and toxic gases can

make you drowsy, disoriented and short of breath.
The odorless, colorless fumes can lull you into a deep
sleep before the flames reach your door.  You may
not wake up in time to escape.

Fire Safety Tips
In the event of a fire, remember time is the big-

gest enemy and every second counts!
Escape first, then call for help. Develop a home

fire escape plan and designate a meeting place out-
side.

Make sure everyone in the family knows two ways
to escape from every room. Practice feeling your way
out with your eyes closed. Never stand up in a fire,
always crawl low under the smoke and try to keep
your mouth covered. Never return to a burning build-
ing for any reason; it may cost you your life.

Hot topics
with Fire
Inspector
Ehrman

Harry Ehrman, III
Fire Inspector
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No matter how long you’ve been using Microsoft
Word, you can always learn new techniques to help
you work faster and smarter.

The next three editions of The Challenge will fea-
ture Microsoft Word tips that range from basic to
Advanced and Things you don’t have to do.  Here
are some favorite tips and tricks for Word 97/2000/
XP:

THE BASICS
* Learn to use Undo. Make a mistake? Press

[Ctrl]Z or choose Undo from the Edit menu right
away. Keep pressing [Ctrl]Z to backtrack through and
undo the most recent editing changes you’ve made.

* Save often. Press [Ctrl]S or click the Save
button on the Standard toolbar. Save your work fre-
quently. You can also instruct Word to automatically
save your work periodically. Open the Tools menu,
select Options, click the Save tab, and activate the
Save AutoRecovery Info Every option. You can
specify an interval from 1 to 120 minutes.

* Quickly move around in a document. To
move to the top of a document, press [Ctrl][Home].
To move to the bottom of a document, press
[Ctrl][End]. To go to the top of the next page, press
[Ctrl][Page Down]. For the top of the preceding page,
press [Ctrl][Page Up].

* Open menus and select commands from the
keyboard. Press [Alt] plus the letter that’s underlined
to open a menu, such as File, Edit, View, and so on.
Once a menu is open, you don’t need to press [Alt]
to select a command; just press the underlined letter
of the command you want to select. Here are some

common examples: Quick Print Preview: [Alt]F,V.
Quick Save As: [Alt]F,A. Quickly reopen the first
document in the most recently used file list: [Alt]F,1.

* Four ways to select a block of text.
· Use the mouse. Just click and drag the mouse to

select text.
· Use [Shift] plus the arrow keys. Hold down

[Shift] and press an arrow key to select text in the
desired direction. To select a word at a time, press
[Ctrl][Shift] and the left or right arrow key.

· Use the mouse with the [Shift] key. Move the
mouse pointer away from the insertion point position,
hold down [Shift] and click to select all the text be-
tween the insertion point and the place where you
clicked.

· Frustrated when you try to select text with the
mouse past the bottom of the currently visible page
and Word leaps past what you want to select? Those
are the times to use [Shift] plus the down arrow key
instead of the mouse.

* Select a word. Double-click on it. If a space
immediately follows the word you select, the space
gets selected, too. Punctuation is ignored.

* Select a sentence. Hold down [Ctrl] and click
anywhere in the sentence.

* Select a paragraph. Triple-click within the
paragraph or move the mouse just past the left mar-
gin of the paragraph. When the pointer changes to a
right-pointing arrow, double-click to select the whole
paragraph.

* Select a table. Select a table by holding down
[Alt] and double-clicking anywhere in the table.

* Select all the text between the insertion
point and… To select all the text between the inser-
tion point and the end of the current line, press
[Shift][End]. To select the text from the insertion point
through the end of the current paragraph, press
[Ctrl][Shift] and the down arrow. To select the text
from the insertion point to the end of the document,
press [Ctrl][Shift][End].

* Select an entire document. Press [Ctrl]A.
This is handy when you need to change the font or add
or remove formatting.  Once you’ve selected the en-
tire document, apply the formatting to everything and
either leave it applied or apply it again to remove it.
For example, suppose some text in your document is
underlined and you want nothing underlined.  To avoid
spending time visiting each underlined section of text
and un-underlining it, select the whole document with
[Ctrl]A. Press [Ctrl]U to apply underlining to the en-
tire document and then press [Ctrl]U again to remove
the underlining. Be careful when you use [Ctrl]A. If
you accidentally press [Delete] or type a keystroke
and erase everything, don’t panic. Just press [Ctrl]Z
or choose Undo from the Edit menu.

* Grow font, shrink font. Here are three quick
ways to change the size of selected text: Choose Font
from the Format menu and specify the desired point
size. Click the Font Size button on the Formatting
toolbar and select an entry from the drop-down list.
Or use the Grow Font and Shrink Font shortcuts,
which are [Ctrl] plus the close- and open- square
bracket characters, respectively.

* Rename an existing document. Use Save As.
When you need to use an existing document as the
basis for a new one, don’t overwrite the old docu-
ment. As soon as you open it, press [Alt]F and then
press A. (Or open the File menu and choose Save
As.) Then immediately type a new name or change
some part of the old one.

* Print envelopes. Want to address your enve-
lopes in the printer? Type an address in a blank
document or in a letter. Open the Tools menu and
select Envelopes And Labels. (Word XP users choose
Letters And Mailings and then select Envelopes And
Labels.) In the Envelopes tab, enter the return address
if you want one, and click Print.

* Expand your vocabulary. Word has a built-
in thesaurus. Press [Shift][F7] or open the Tools menu,
select Language, and then choose Thesaurus. Word
will display a list of synonyms for the word you’ve se-
lected or the word closest to the insertion point marker.

* Make friends with the right mouse button.
Don’t be afraid to right-click on a block of text or a
table cell. The shortcut menu offers immediate access
to some handy formatting options.

* Paste plain text. When you copy and paste
text from a Web page or another document, the text
brings its formatting into your document. To get around
that behavior, copy the text and place the insertion
point marker where you want to insert the copy. Then,
open the Edit menu, choose Paste Special, and select
the Unformatted Text option.

Indispensable tips for Word users - Part I

It was a a pleasure for Command Sgt. Maj. Otis Cuffee, TACOM CSM to have lunch with a few
senior Soldiers of the 345th Combat Support Hospital unit, especially since there are no Soldiers
assigned to SIAD, during his recent visit here.  Cuffee enjoyed hearing the unit explain their
purpose for being on the installation which was performing medical reset of their assets.

Soldiers enjoy lunch with TACOM CSM

Photo Submitted
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Skedaddle Inn Meeting Center
The Skedaddle Inn Meeting Cen-

ter/Lounge is now open Monday
through Thursday, 6:30 a.m. to 5:00
p.m., Thursdays until the last customer
leaves.  It is also equipped to cater large
or small events.

Call the manager at 827-4360 or
email: skedaddle.inn@sierra.army.mil.
Business hours are Monday through
Friday, 6:30 a.m. to 5:00 p.m.

Sierra Lodge/Guest House
Call the depot lodging manager,

827-4544, or email:
skedaddle.inn@sierra.army.mil for in-
formation.  Room rates from $50.00 -
$60.00 per person.

Sierra Bowling Center and
Snack Bar

Open  Monday through Saturday,
11:00 a.m. to 8:00 p.m. Call 827-4442
for information.  Check out the Lunch
Specials that are advertised Monday
through Thursday. Delivery available
on all orders received before 10:30
a.m.  Contact the Snack Bar to book
your birthday packages and holiday
parties early.

Physical Fitness Center

Open Monday through Thursday,
11:00 a.m. to 1:00 p.m. and 5:00 p.m.
to 8:00 p.m.  Open Friday, Saturday,
Sunday from 11:00 a.m. to 1:00 p.m.
There is no charge for general use for
military and depot personnel.  For other
authorized patrons, there is a $2.00
daily charge with special monthly rates
available.  Regular membership is
$20.00, premier membership is
$40.00.  A tanning bed is also available
at a rate of $6.00 per tan or a monthly
rate of $35.00.  Use of the Racquet-
ball Courts is only $3.00 per hour.

Now available - Prepaid orders for
custom hats, jackets, and shirts with
depot logos.

ITR is available at the Physical Fit-
ness Center.  For more information call
827-4655 or email
ITR@sierra.army.mil or
ok.fern@sierra.army.mil.

Outdoor and Equipment Rental
Party rental items are now avail-

able along with ATVs.  A safety class
is no longer required to rent ATVs
and Boats.  However, you must take
the State of California test for water
craft,.  Now is a great time to get it done

- Warm weather is just around the cor-
ner.  Books and test are available at the
gym during regular business hours -
THIS IS A REQUIREMENT TO
RENT ANY WATER CRAFT.  For
information call Erika Manfull at
(530)827-4655 or send an e-mail to
erika.manfull@sierra.army.mil

Laundromat
Open daily, 6:00 a.m to 10:00 p.m.

in building 142. Cost for wash, $1.25
and $.50 cents with a longer drying
cycle. Please call 827-4655 for addi-
tional information.

Recycling Center
Open Monday through Thursday,

6:30 a.m. to 5:00 p.m. Call 827-4504
or email
christopher.long@sierra.army.mil to
schedule a pick up or service.

Swimming Pool
Open Tuesday through Sunday,

11:00 a.m. to 7:00 p.m.  Cost of for a
single season pass:  Active Duty Mili-
tary - Free; Dependents of E-1 to E-5,
Civlians & Dependents GS-01 to GS-
05, WG-01 to WG-02 - $20.00; All
others - $30.00.  Cost for a family
pass:  Dependents of E-1 to E-5,

Fetal Alcohol Syndrome (FAS) is
caused by the mother’s heavy use of
alcohol during pregnancy.     Fetal Al-
cohol Effects (FAE) is caused by an
unborned child being exposed to alco-
hol in the mother’s womb.

What you need to know about:
FETAL ALCOHOL SYNDROME

- Every time a pregnant woman has
a drink, the BAC (blood alcohol con-

2006 Annual Easter Party
CYS Children’s Annual Easter

Party was filled with excitement, fun,
and magic.  Mrs. Magic entertained us
with all of her exciting magic tricks and
balloon animals.  The Easter bunny was
there to take pictures with all the chil-
dren and youth, and the weather was
perfect for all of the Easter egg hunts.
We had refreshments, prizes, and give-
aways so no child went home empty
handed.  The event was successful and

everyone had a great time.  Thank you
to all the adult and youth volunteers that
assisted us.  CYS would like to give a
special “THANK YOU” to the Sierra
Army Depot Fire Department for all
their help and support every year with
the Easter party!

Volunteer of the Month Award
Ceremony

CYS awarded eight youth volun-
teers last month during the Volunteer of
the Month Award Ceremony.  The
Volunteer Award Ceremony is done

Youth Services monthly update corner
quarterly to honor CYS school age
youth, middle school, and teen volun-
teers. George Ray the Chief of Staff had
the honor of awarding our youth their
certificates.  The youth volunteers
awarded were Justin White, Tori
Hamilton, Mitchell Tescher, Antionette
Lopez, David Davis, Zanetta Newton,
Austin Newell, and Alex Harris. Alex’s
sister Danielle Harris received the
award for her.  Congratulations to ev-
eryone and keep up the great work!!!

 CYS Mother’s Day Tea Party

Child and Youth Services staff and
youth want to honor and celebrate our
Mother’s in a speical way.  This year
the youth and staff are putting on a
Mother’s Day Tea event.  All Mother’s
and Grandmother’s of youth from CYS
are welcome  to attend our Mother’s
Day Tea event.  The tea party will take
place on Thursday, May 11th, at 5:30
p.m. at the CYS.  Please come and join
us in celebrating and honoring CYS
Mother’s.

By Lanaya Chapman
Youth Services

Fetal alcohol
awareness

2006 Easter Party Volunteers of the Month

Photo SubmittedPhoto Submitted

Civlians & Dependents GS-01 to GS-
05, WG-01 to WG-02 - $60.00; All
others - $70.00.

MWR Office
The Administrative Assistant can

be reached at (530) 827-4497, Mon-
day through Thursday, 6:30 a.m. until
5:00 p.m., or send an email to
diane.plaster@sierra.army.mil.  Busi-
ness Office is (530) 827-4178 or
(530) 827-4609.

FAS (See Page 11)
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Want to start your own van pool?
Contact Lori McDonald at 4343 and
we will arrange meetings with the cur-
rent van pool owners and provide both
parties a place in the Challenge to ad-
vertise available space and potential
riders.

Community Bulletin
Editor’s Note:  The Community Bulletin provides an avenue for depot em-

ployees to advertise van or car pools, and for-sale items.  Money making items
such as rentals and personal business will not be accepted.

All information to be considered must be submitted via e-mail to
Lori.McDonald@sierra.army.mil, or written items delivered to the Public Af-
fairs Office.

Submission must include a name and telephone extension.  Only home phone
numbers will be published in The Challenge.  Ads will be published in four con-
secutive newspapers.  It is the customer’s responsibilty to update or renew items
listed in the Community Bulletin.

For more information, call Lori McDonald, X4343.

 Van Pools
Garage
Sale ItemsAlvarez says......

Sgt. Alvarez

A current problem the Law En-
forcement Division is experiencing is
the reporting of lost or stolen depot
access badges.  This applies mainly to
those employees who can arrive at
their work location using only their
common access card.  Here’s how
this scenario works out.  Generally an
employee would have been turned
around at the main gate if they could
not produce a legitimate Sierra Army
Depot access badge.  This employee
would in turn report to the Pass & I.D.
office to get a temporary badge.  The
Pass & I.D. office would point them
to the Emergency Services Dispatch
to report the lost or stolen badge.
Lately employees that have lost, or
have had stolen their depot badge will
continue to their work location by dis-
playing a common access card each
morning to the guard at the main gate.

Sooner or later, mostly a lot later,
the employee will report the lost or sto-
len badge to the Emergency Services
Dispatch.  If the badge is lost, it can be
acquired by anyone for any purpose.
If stolen, the perpetrator may try to
gain unlawful access to the depot.  In
either case it is important the Law En-
forcement Division knows about the
missing badge as soon as possible.
Once you are aware that you no longer
have possession of your depot access
badge, and you have searched your;
work site, home, backpack and the
vehicles you have been traveling in,
report it in a timely manner to the
Emergency Services Dispatch at build-
ing P-100.  It will take about 15
minutes to complete the forms and send
you on your way.

Appreciate your help in this mat-
ter.

Lost Badges 4x4 Truck for Sale - 1997 Ford
Crew Cab, seats 6, Auto-trans,
equipped nicely, Great Family Recre-
ational Vehicle, very clean reliable
truck, asking $15,000 or will consider
part trade for an older Toyota 4X4.
Please call evenings between 6 p.m.
and 7:30 p.m. at (530) 253-3805 and
ask for Russ.

A Drug Abuse Resistance Educa-
tion graduation was held here in the
Skedaddle Inn, March 24, 2006 for the
4th and 5th grade classes of Fort Sage
Sierra Primary School in Herlong.

The students completed 17 weeks
of DARE training where they learned
the importance of consequences, deci-
sion making skills, self esteem, and
ways to say no to drugs, violence and
gangs.  They also learned about posi-
tive activities they can be involved with.

The DARE program is taught by Si-
erra Army Depot Police Officer Robert

Brent, Directorate of Emergency Ser-
vices, Law Enforcement Division and is
the only DARE program within Lassen
County.

Before the students are eligible to
graduate from the program, they must
write an essay on “How to Be Drug
Free.”  This year’s winners are Angela
Hawley and David Silva.  Congratula-
tions to these two individuals for
excellent essays.

We also applaud the other students
for their initiative in taking the steps for-
ward to further educate themselves
about how drug abuse can affect the
rest of their lives.

By Robert Brent
DARE Instructor

DARE program educates
students - Say no to drugs
and violence!

This year’s winner of the essay contest that is a requirement prior to
graduating from the DARE Program are David Silva and Angela Hawley.

Photo by Robert Brent

tent) in the mother is the same as the
BAC in the baby.

- Alcohol and other substances can
damage the developing baby’s brain.
Even moderate and light drinking can
put the baby’s health at risk.

- The leading cause of brain dam-
age in newborns is caused by Fetal
Alcohol Syndrome

- Women of childbearing age (18 -
44) or pregnant woman are more likely
to drink if their male partners drink.

For National Alcohol and Other
Drug Related Birth Defects Week,
May 14-20, 2006,  the Alcohol and
Drug Control Officer (ADCO) will
have an information booth at the Food
Wagon in the Mission area on 18 May
06 from 1000 to 1400 so more people
can learn how to prevent this problem.
Our children are our future.

Employees can also call the ADCO
at 826-4190 to get information about
any substance abuse related problem.

FAS (From Page 10)
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Public Affairs Office

Sierra Army Depot

74 C Street

Herlong, CA  96113

The Civilian Personnel Advisory
Center is now fully staffed and ready to
provided any assistance when needed.
This will be the beginning of a CPAC
corner in the monthly edition of The
Challenge.  To help employees know
who to talk with when they need help,
a short background on each one is pro-
vided below to include the areas of
responsibility.

Human Resource Officer
(CPAC Chief) – Kathleen L.
Schneider (“Kay”) – Has 28 years of
government service.  Kay provides hu-
man resource service in an
administrative and advisory capacity.
She directs the CPAC operations
through human resource specialists and
assistants.  Serves as a consultant and
troubleshooter to management on per-
sonnel management matters.  Kay is
married and has two children and three
grandchildren and enjoys the outdoor
activities of hiking, camping and garden-
ing.  She can be reached at extension
4255.

Human Resource Specialist
(Staffing & Recruitment) – Edna J.
Robles (“Joleen”) – Worked for the
Forest Service for 29 years in Person-
nel and Civil Rights and started working
for Sierra Army Depot in September
2005.   Joleen handles all staffing and
recruitment actions as well as the leave
donation program, requests for ad-
vance leave, and retirements.  Joleen is
married, has two sons and six
grandkids.  She enjoys all sporting
events, especially those her children/
grandchildren are involved in. She is at
extension 4333.

Human Resource Specialist
(MER & Labor) – Lori M. King –
Started working for Department of
Army in 1989 at Sierra Army Depot
and has been in the civilian personnel
field since 1990.  She left Sierra in
1999, when civilian personnel was re-
gionalized and recently returned from
Fort Huachuca in December 2005.
Lori serves as the principle point of
contact between management and the
union.  She provides advice and assis-
tance to management in the resolution
of labor and MER issues.  She also
provides advice and guidance in per-
formance management. Lori is married
to Brian (Sierra firefighter), has three

Meet Your Civilian Person-
nel Advisory Center
(CPAC) Personnel
By Joleen Robles
HR Specialist

children and six grandkids.  She enjoys
traveling and hiking on her time off.  Her
extension is 4313.

Human Resources Assistant
(Employee Benefits) – Charvette
Comier – Worked in the Sierra Safety
Office for 9 1/2 years as a Safety Tech-
nician and transferred to the CPAC in
October 2005.  She has a total of 21
years of federal service.  Charvette
manages the Workers Compensation
Program.  She advises employees and
supervisors of the procedures to follow
when an injury occurs.  She is the cen-
tral point of contact for traumatic and
occupational injury claims.  If you have
an on-the-job injury, Charvette is the
one to see, her extension is 4450.

Human Resources Assistant –
Judith A. Everett (“Jude”) – Has
worked for Sierra for 16 years and has
20 years of federal service.  Jude
handles all Non Appropriated Fund
(NAF) personnel actions, processes in
new hires, and helps employees with
their benefits.  She sets up medical ap-
pointments and can answer employee’s
general personnel questions.  She is also
the Depot Passport Agent.  If you are
being sent overseas, please see Jude to
ensure that you receive your government
passport before you deploy.  Jude can
be reached at extension 4407.

The friendly staff of the Civlian Personnel Advisory Center are always willing
to lend a helping hand.  The smiling faces of the CPAC ladies are - front row
left to right, Charvette Comier and Kay Schneider  Back row, left to right,
Lori King, Joleen Robles and Jude Everett.  The CPAC Office is located in
the headquarters building, P-150, just as you come in the front door.  So if
you need assistance, or just want to get to know them, don’t be afraid to
stop by, they don’t bite!

Photo by Lori McDonald

Here is some critical information to
limit the damage in case this happens
to you or someone you know:

1. We have been told we should
cancel our credit cards immediately.
The key is having the toll free numbers
and your card numbers handy so you
know whom to call. Keep those where
you can find them.

2. File a police report immediately
in the jurisdiction where your credit
cards, etc., were stolen. This proves to
credit providers you were diligent.

3. Call the three national credit re-
porting organizations immediately to
place a fraud alert on your name and
Social Security number.  Here are the
numbers you always need to contact:

(1) Equifax: 1-800-525-6285; (2)
Experian (formerly TRW): 1-888-397-
3742; (3) TransUnion:
1-800-680-7289; (4) Social Security
Administration (fraud line): 1-800-269-
0271 A corporate attorney sent the
following out to the employees in his
company.

ADVICE (From Page 4)

May 20, 2006


